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Read these operating instructions carefully  before using the Thermostat System. Follow the 
safety instructions listed below. The heaters associated with the thermostat system can cause 
serious injury. They are capable of extremely high temperatures. 

1) DO NOT attach heaters to the thermostat board during programming.  

2) Make sure the power is OFF before connecting the thermostat to the thermostat program-
ming board. 

3) DO NOT operate heaters in free air. They can generate enough heat to cause injury or 
damage the heaters themselves. 

4) Install the heaters and thermostat in the final unit before applying power. 

5) Heaters must be secured to a metal surface shared with the thermostat for proper opera-
tion. The thermostat must be able to measure the heat generated as a result of the heaters. 

6) The thermostat is factory set to turn the heaters on at 5 degrees C and turn them off at 20 
degrees C. The thermostat programmer may be used to change these settings. 

 



4  

 

Always on Target  

Graflex, Incorporated 

Table of  Contents 

For further information, contact:     
      Graflex, Incorporated  
Voice: 561-691-5959; Fax 561-691-5983  15855 Assembly Loop, Suite 100 
email: Sales@Graflex.com   Jupiter, Florida  33478  USA 

 
1.0 Introduction  .............................................................................................. 4 

    

2.0 Item Description  ....................................................................................... 5  

  2.1 Thermostat ......................................................................................................... 6 

  2.2 Heater ................................................................................................................. 8 

  2.3 Thermostat Programmer .................................................................................. 9 

   

3.0 Graphical User Interface (GUI) ............................................................... 10  

  3.1 Menu Items......................................................................................................... 11 

  3.1.1 File Menu ......................................................................................................... 11 

  3.1.2 Comm Port Menu ........................................................................................... 11 

  3.1.3 Temperature Reading .................................................................................... 12 

  3.1.3.1 Continuous Update ...................................................................................... 12 

  3.1.3.2 Format  ......................................................................................................... 12 

  3.1.4 About Menu .................................................................................................... 13 

  3.2 Controls and Indicators .................................................................................... 14 

  3.2.1 Current Temperature .................................................................................... 15 

  3.2.2 Get Thermostat Values Frame ...................................................................... 15 

  3.2.3 Set Thermostat Temperature Frame ............................................................ 16 

  3.2.4 Exit Button ...................................................................................................... 16 

 

4.0 Operation ................................................................................................... 17 

  4.1 Thermostat Programming ................................................................................ 17 

  4.2 Thermostat and Heaters ................................................................................... 18 

   



5  

 

Always on Target  

Graflex, Incorporated 
For further information, contact:     
      Graflex, Incorporated  
Voice: 561-691-5959; Fax 561-691-5983  15855 Assembly Loop, Suite 100 
email: Sales@Graflex.com   Jupiter, Florida  33478  USA 

1.0 Introduction 

 

The  Thermostat System is designed to allow a user to determine the temperature  range for his 
thermostat. This is accomplished by a programmable thermostat and a thermostat programmer 
board. The thermostat programmer board is then controlled by a GUI that allows the user to interact 
with the thermostat and set the temperature for the heaters to turn on and to turn off. 

The following paragraphs will describe the thermostat as well as the thermostat programmer. 
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2.0 Item Descriptions 

There are 3 primary hardware elements to the system: 

 Thermostat 

 Thermostat Programmer 

 Heaters 

The Thermostat and Heaters will be installed in the user hardware. The Thermostat Programmer is 
to be used external to the user final product. If the user wants to set the thermostat to a temperature 
range different from the factory settings, the Thermostat Programmer must be deployed. 

2.1 Thermostat 

 The Thermostat board is shown in Figure 2.1 below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are several interface cables attached to the Thermostat board as shown above. There can be 
up to 4 heaters attached to the Thermostat. It is recommended that all heaters be with 4 inches of 
the Thermostat board and positioned such that the Thermostat can detect the heat rise associated 
with the heaters being ON. The 4 heater connectors are J2, J3, J4 and J5. 

The heaters can be up to 15 watts each but the system, as delivered, is configured with 3 each 4.8 
watt heaters for a total heating power of 14.4 Watts and one unused connector. This unused con-
nector may be useful for a customer furnished LED indicator to visually indicate when the heaters 
are ON. Be sure to use the appropriate value series resistor if an LED is used. 

Heater Interface 
Connectors 

Power Input Connectors 

Thermostat Programmer 
Interface Connector 

Figure 2.1 Thermostat  



7  

 

Always on Target  

Graflex, Incorporated 
For further information, contact:     
      Graflex, Incorporated  
Voice: 561-691-5959; Fax 561-691-5983  15855 Assembly Loop, Suite 100 
email: Sales@Graflex.com   Jupiter, Florida  33478  USA 

2.1 Thermostat continued 

 

In addition to the 4 heater interface connectors, there is also an connector interface to power (J1) 
and to the Thermostat Programmer (J6).  

The power connector interface (J1) is a heavy gauge wire(AWG18) and connector capable of han-
dling the current required when there are four 15 watt heaters attached to the Thermostat. All of the 
current for the 4 heaters must pass through this connector interface. 

 

The Thermostat Programmer connector is a 4 pin Hirose connector. This connector connects the 
Thermostat to the Thermostat Programmer to allow the custom temperature ON/OFF user settings 
to be set. 

 

Table 2.1 below presents the mating connectors and contact pins 

 

 

 

 

 

 

 

 

 

 

 

 

Name J# Connector P/
N 

Manufacturer Contact P/N 

Power Input J1 03-06-2023 Molex  

   Molex, Female 02-06-1103 

Heater and LED J2, J3, J4 and J5 DF3-2S-2C Hirose  

   Hirose, Male DF3-2428SC 

Thermostat Programmer J6 DF3-4EP-2C Hirose,  

   Hirose, Male DF3-
EP2428PC 

# of Pins 

 

2 

 

2 

 

4 

Table 2.1 Thermostat Mating Connectors 
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2.2 Heater 

 The heater is shown below in Figure 2.2.1and attached to the thermostat in Figure 2.2.2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The heaters are purchased and the wiring shortened to 3 inches and terminated with a connector to 
interface to the thermostat board. The connector information is presented in Table 2.2. 

Figure 2.2.2 Heaters Attached to Thermostat  

Figure 2.2.1 Heater 

Name J# Connector P/
N 

Manufacturer Contact P/N # of Pins 

Heater Connector J1 DF3-2S-2C Hirose   

   Hirose, Male DF3-2428SC 2 

Table 2.2 Heater Connectors 
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2.3 Thermostat Programmer 

 The Thermostat Programming board is shown in Figure 2.3. The Thermostat board provides the 
hardware interface between the PC Graphical User Interface (GUI) and the Thermostat. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ultimately, the Thermostat Programmer will be housed in a small chassis. The information provid-
ed here is to allow interfacing directly from the Thermostat board to the Thermostat Programming 
board. The actual operation of the system will be described as part of the GUI discussion in para-
graph 3.0. Table 2.3 below presents the Thermostat Programmer board mating connectors.  

 

 

Figure 2.3 Thermostat Programmer Board 

Name J# Connector P/N Manufacturer Contact P/N # of Pins 

Power Input J1 22-01-3027 Molex   

   Molex, Female 08-50-0114 2 

9 Pin D J2 L717S-DE09P Amphenol N/A N/A 

   Molex, Female 08-50-0114 5 

Thermostat Interface J3 22-01-3057 Molex   

Table 2.3 Thermostat Programmer mating connectors 

J1: Power Input 

J2: Interface 
to Thermostat 

J2: RS-232 Serial IO to GUI 
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3.0 Graphical User Interface (GUI) 

 

In order to program the Thermostat to turn the heaters on and off, a Thermostat Programmer GUI 
has been developed. In describing the GUI operation, we will also be describing the operation of 
the overall Thermostat system. To begin, we will describe the basics of the GUI starting with the 
menu selections and then the user operation of the system. 

A screenshot of the GUI is shown in Figure 3.0. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.0 GUI Screenshot 
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3.1 Menu Items 

 

The menu bar is shown below indicating each of the basic menu categories. 

 

 

3.1.1 File Menu 

The File Menu has a single menu item “Exit” as shown below. When the “Exit “ menu item is 
clicked, the application terminates. The application also terminates when the “exit” button is 
clicked. 

 

 

 

 

3.1.2 Comm Port 

The Comm Port menu item has several menu items as shown below. 

There are a total of 16 Comm Ports available for selection and only 
those that are available as serial communications ports are shown in 
bold and the others are “grayed” out. 

To select an available Comm  Port, simply click on the desired Comm 
Port and a check mark will be displayed next to the chosen comport. 

The selected Comm Port is stored in the computer and when the appli-
cation is restarted, the originally selected Comm Port will once again 
be selected. To change Comm Ports, simply click on a new Comm Port 
and it will replace the one previous stored. 
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3.1.3 Temperature Reading 

The Temperature Reading Menu has two main menu items: “Format” and “Disable/Enable Contin-
uous Update” as shown below 

 

 

 

 

3.1.3.1 Continuous Update 

When the menu item “Disable Continuous Update” is shown, the GUI will automatically query the 
Thermostat Programmer board and the Thermostat and retrieve the latest Thermostat ON Tempera-
ture, OFF Temperature and Current Temperature. These displays are further discussed in paragraph 
3.2 Controls and Indicators. 

When the menu item “Enable Continuous Update is shown, the GUI will not update the ON Tem-
perature, OFF Temperature and Current Temperature unless the “Get Current Values” button is 
clicked in the main GUII. 

2.1.3.2 Format 

Also included in this menu is the ability to select temperature readings to be shown in either Fahr-
enheit or Centigrade. The menu item below shows Fahrenheit as the format for all temperature 
readings and settings. Note the check mark next to Fahrenheit in the submenu. 

 

 

 

To change to Centigrade, simply click on the submenu “Centigrade” item and Centigrade will be 
used for all temperature readings and settings. The menu below shows the Centigrade submenu 
item selected. 
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3.1.4 About... 

The About Menu will immediately display the “About” form. This form provides pertinent infor-
mation about Graflex, Inc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To close the “About” form either click the close control at the upper right hand corner of the form 
or select “Exit” from the File menu. Either will close the “About” form and not affect the main ap-
plication. 



14  

 

Always on Target  

Graflex, Incorporated 
For further information, contact:     
      Graflex, Incorporated  
Voice: 561-691-5959; Fax 561-691-5983  15855 Assembly Loop, Suite 100 
email: Sales@Graflex.com   Jupiter, Florida  33478  USA 

  

3.2 Controls and Indicators 

The controls and indicators necessary to easily program a Thermostat are shown once again on the 
main GUI display. 

This section will briefly describe each of the control and indicator areas on the display: Current 
Temperature, Get Thermostat Values, Set Thermostat Values and the “Exit” button. 
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3.2.1 Current Temperature 

The Current Temperature display may be shown in either Fahrenheit or Centigrade. 

If the Temperature Reading menu item “Format” submenu item “Fahrenheit” is checked the current 
temperature will be shown Fahrenheit. 

 

 

 

While if the Temperature Reading menu item “Format” submenu item “Centigrade” is checked the 
current temperature will be shown Centigrade. 

 

 

 

3.2.2  Get Thermostat Values Frame 

The “Get Thermostat Values “ frame contains two displays and one button. The displays “Current 
ON Temperature” and Current OFF Temperature will display the temperature in either Fahrenheit 
or Centigrade depending on the “Format” submenu item selection. 

 

 

 

 

 

 

 

 

When the “Get Current Values” button is clicked, the GUI will  query the Thermostat Programmer 
board and the Thermostat and retrieve the latest Thermostat ON Temperature, OFF Temperature 
and Current Temperature.  

If the menu item “Disable Continuous Update” is shown, the GUI will automatically query the 
Thermostat Programmer board and the Thermostat and retrieve the latest Thermostat ON Tempera-
ture, OFF Temperature and Current Temperature and not require the “Get Current Values” button 
to be clicked. 
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3.2.3 Set Thermostat Temperature Frame 

Like the Current Temperature, the temperature values displayed in the “Set Thermostat Tempera-
ture” frame may be in either Fahrenheit or Centigrade depending upon the on the “Format” sub-
menu item selection as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are two vertical sliders on the frame; one to adjust the temperature the heaters will turn on 
(ON Temp) and one to adjust the temperature the heaters will turn off (OFF Temp). The OFF tem-
perature must be higher than the ON temperature for the thermostat to work properly. 

The default ON temperature is 41 degrees Fahrenheit (5 degrees Centigrade) and the default OFF 
temperature is 68 degrees Fahrenheit (20 degrees Centigrade). 

 

3.2.4 Exit Button 

The “Exit” button shown below will terminate the application in the same manner as the File menu 
item “Exit”. The application may also be terminated by clicking the Close control at the top left 
corner of the application. 
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4.0 Operation 

 

If the factory settings of 5 degrees Centigrade for the heaters to turn on and 20 degrees Centigrade 
for the heaters to turn off are acceptable, then go to paragraph 4.2. Otherwise the following para-
graph 4.1 will describe how to program the thermostat. 

4.1 Thermostat Programming 

Figure 4.1 below illustrates the components needed to program the Thermostat. The Graflex Ther-
mostat Programming Chassis houses the Thermostat Programmer board and internal cabling. The 
Graflex Thermostat Programming Chassis is supplied with a power supply and power cable as well 
as the Interface cable for attaching to the Thermostat board. 

Make sure the Power Supply is not plugged into the wall until all of the components are wired.  

Do Not attach heaters when programming the Thermostat. Heaters must not be powered in a “free 
air” configuration 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.1 Thermostat Programmer Block Diagram 
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Once the system has been configured for programming, apply power to the +12 VDC power supply 
and open the Thermostat Programmer v1.2 GUI. 

Set the Temperature Reading menu item for continuous updates to read “Disable Continuous Up-
date” and the following displays should be updating and displaying factory settings: 

 Current Temperature: the actual current temperature 

 Current ON Temperature: 5 degrees C or 41 degrees F 

 Current OFF Temperature: 20 degrees C or 68 degrees F 

Adjust the ON Temp and OFF Temp sliders until the desired ON and OFF temperatures are set. 
The temperature values are automatically stored in the Thermostat’s memory. 

Power the system off and remove the Thermostat from the programming environment. The Ther-
mostat is now ready for installation 

4.2 Thermostat and Heaters 

The Thermostat and Heaters are now ready for installation. To mount the Thermostat: 

 Determine the location of the Thermostat and mark the mounting hole locations.  

 Drill and tap the mounting hole locations  

 Secure the Thermostat to the surface either directly or via small standoffs. 

To mount the heaters: 

 Locate the proper location for the Heaters to be mounted  

 Make sure the heater cables are long enough to attach to the Thermostat.  

 Peel the protective backing off of the Heaters and attach them to the desired surface.  

Interface the Thermostat and Heaters: 

 The +12 VDC power must be off 

 Connect the heaters to the Thermostat 

 Attach a power cable to the Thermostat 

 Apply power on 

 

 

 


